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Microsoft ships each copy of Windows with "default" settings that are designed to be "good 

enough" for most people. The default settings are a kind of lowest common denominator, 

ensuring that the operating system will work okay for the mythical "average user."  

But, if you're reading this, chances are you're not an average user. You probably know that you 

can unlock much more of your system's potential by changing Windows' default settings to suit 

your own particular working style and circumstances.  

Today, I'll tell you 10 things I do to make my copies of Windows XP Professional run better. I'll 

also explain why I make these changes, so you can better decide if using the same tweak (or 

some variation) will work for you.  

Of course, 10 is an arbitrary number. There are actually thousands of possible tweaks; 

Microsoft's printed "XP Resource Kit Documentation" is 1,699 pages long! Some tweaks listed 

here are "tip of the iceberg" things, and can lead you to additional sublevels of system 

adjustments to explore.  

Each XP user will approach the operating system in a slightly different way. You might rank-

order these 10 tweaks differently or develop an entirely different list. In fact, I hope you do. 

Please check out my 10 tweaks, and then use the discussion area associated with this article to 

post your own.  

By the time we're done, we should have an awesome collection of real-world, real-life tweaks 

that can help make XP work just the way we want it to--instead of the way Microsoft wants it to.  

Before Digging In 
Tweaking isn't for everyone. If you're using XP and you like it as-is, leave things alone. Don't 

make needless changes to your operating system, especially since some changes are hard to 

undo. Likewise, weigh each suggestion against the likely benefit you'll gain. Don't tear apart a 

working operating system or subsystem unless you believe the results are truly worth it.  

Of course, before you do significant system work on any operating system, always make a full 

backup. You need to be able to restore things to the way they were before, if a change doesn't 

work out the way you intended.  

In XP, it's also a good idea to make a "Restore Point" (click Control Panel/Performance and 

Maintenance/System Restore) and select "Create a restore point" before each and every 
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change. System Restore can roll back many minor system changes without requiring you to 

restore your full backup.  

Also, it makes no sense to try to tune and tweak an operating system that's fundamentally 

incomplete or broken. So, before you start changing anything, right-click on My Computer and 

select Properties/Hardware/Device Manager to ensure all your hardware is set up and 

running properly. In addition, use Windows Update to download and install all current patches 

and driver updates.  

Once you're ready to go, dive in!  

1) Tune XP's Visual Performance 

Depending on how you set it up, XP may have reserved a substantial amount of your CPU 

horsepower for things like animating various desktop elements, placing shadows under menus 

and cursors, and rounding the upper corners of open windows. In the aggregate, these visual 

effects can slow down screen-drawing operations significantly. Also, XP may have selected a 

"color depth" for your video system in excess of what you really need; this, too, can slow down 

screen operations.  

To adjust the color depth, right click anywhere on an empty portion of your desktop and select 

Properties/Settings. For most normal business users, the Color Quality setting should be set to 

Medium (16 bit). Higher settings do matter in photo/video editing and similar applications, but 

for mundane things like Web browsing, E-mail, and word processing, the Medium setting is fully 

adequate, and it's faster.  

To adjust XP's desktop animations and visual effects, right click on My Computer and select 

Properties/Advanced/Performance Settings. You can choose to activate/deactivate 

individual items or use the general "best performance/best appearance" buttons. When you've 

made a change, click Apply, and you'll see the effects almost immediately. (By the way: 

Selecting Best Performance makes your desktop look very much like the classic desktop in 

Win98/Win2K.) Experiment until you've found the mix of speed and visual effects that works 

best for you.  

2) Improve XP's Folder Views 
Windows XP's default folder view, with its giant icons, makes me feel as though I'm staring at a 

coloring book instead of a business computer. But you can easily change the folder view to 

something more restrained, space-efficient, and useful.  

Open My Documents. In the View menu, select Status Bar, List, and Arrange Icons by 

Name. Next, right click on an empty spot in the My Documents toolbar and select Customize. 

Choose any of the Available Toolbar Buttons you wish and click Add. (I select the Undo, 

Delete, Cut, Copy, and Paste buttons.) Exit the dialog.  

Now click to the Tools menu and select Folder Options. Under the View tab, tell XP to show 

you the full path, to show hidden and system files, not to hide any file extensions, and not to hide 

protected folders--plus any other settings you want. When you have the folder options set the 



way you desire, click the "Apply to all folders" button at the top of the dialog. This adjusts 

all windows opened by Explorer, so they'll inherit the visual choices you made for this one 

window.  

3) Customize the Taskbar 

Right click on an empty spot in the Task Bar (the bar next to the Start button). Uncheck Lock 

the Taskbar. This lets you resize various portions of the taskbar the way you want them. Now, 

explore the other Taskbar settings to see if any will work for you.  

One I always select is Toolbars/Desktop. I place the new Desktop toolbar far to the right on the 

Taskbar, over by the clock area. Whenever I want access to something on the Desktop that's 

covered with open windows, I can use this new Desktop toolbar as a shortcut to get to the item 

on the Desktop without having to close or move any open window.  

4) Just Say "No" To Phoning-Home 
By default, XP wants to contact the Microsoft servers to auto-search for patches, downloads, and 

updates. It also wants to send Microsoft information about any crashes you experience. The 

former can be an annoyance if the auto-update cycle kicks in at an inopportune time. The latter is 

a potential security hole, because the crash-reporting information includes a mini-dump of XP's 

memory contents; it can include snippets of open documents, passwords you've recently typed, 

and so on.  

You can turn off both behaviors by right clicking on My Computer, selecting Properties, and 

first choosing the Automatic Updates tab. Select either Turn Off or, minimally, Notify me.  

Now select the Advanced tab and click on Error Reporting. Check "Disable error reporting," but 

leave "notify me when critical errors occur" checked.  

5) Control Your Trash 

By default, both the Recycle Bin and Internet Explorer's Cache want to consume ridiculous 

amounts of your hard drive space. Right click on the Recycle Bin, select Properties, and on 

the Global tab, decide how much space you want the Recycle Bin to consume, either for all 

drives in your system, or on a per-drive basis. (It's a percentage of the total space. I adjust the 

slider way to the left, so I'm using "only" a few hundred megs of space for trash.)  

Similarly, open Internet Explorer, and select Tools/Internet Options. Under Temporary 

Internet Files, click the Settings button and select a reasonable size for this cache area. 

Generally speaking, if you have a fast connection, 5 Mbytes to 10 Mbytes is adequate; 25 

Mbytes or so is usually enough with a slower dial-up connection.  

6) Rein In System Restore 

Like the items in No. 5, above, System Restore is an incredible space hog. It might be worth it, if 

System Restore were a truly complete and foolproof form of backup, but it's not. At best, System 

Restore can and will get the core operating system running again after a bad crash, but it doesn't 

return all files to the pre-trouble state, and it can't remove all traces of a program that went bad. 

As a result, System Restore's usefulness is limited, and so should be its appetite for disk space.  



Right click on My Computer, select Properties, and select the System Restore tab. Select 

your main drive (usually C:), click Settings, and move the slider to reserve a reasonable 

amount of disk space. With a good regimen of daily backups, you can even move the slider all 

the way to the left. (I do.)  

If you have more than one drive, you may wish to turn off System Restore entirely for non-

system drives. There's little, if any, benefit to be gained by having them monitored. And if you're 

really religious about making a full backup before you alter your system or install new software, 

you may wish to completely turn off System Restore for all drives.  

7) Improve XP's Virtual Memory Settings 

On its own, Windows places your "swapfile" or "paging file" (a portion of your hard drive that's 

used as a kind of pseudo-RAM) on your C: drive, and sets it up so it can grow and shrink as 

needed. However, you may be able to do better. For example, if you have more than one physical 

disk in your system, you may get better performance from either placing the swapfile on the 

lesser-used disk (assuming it's the same speed as the primary disk) or by splitting the swapfile 

across two disks. You also may see modest improvements in responsiveness if you set the 

swapfile to a fixed size, so Windows won't waste time growing and shrinking the file on demand.  

Swapfile management has been somewhat of a black art in previous versions of Windows, but 

the XP Help System actually has good information on the subject (a first for Windows!). Select 

Help And Support from the Start menu, and do a search for "virtual memory." Be sure to check 

out the "related topics" delivered by the search for additional good information.  

8) Control XP's Hidden Devices 

For reasons known only to the programmers in Redmond, XP may deliberately hide certain 

system devices from you. While this might make a kind of sense in, say, XP Home edition, these 

devices remain hidden even in the Professional edition.  

For example, if you're used to Windows 98's networking applet, you may be surprised by how 

clean and uncluttered XP's networking applet is. But XP may simply be hiding lots of 

networking elements from you. To see if this is the case, right click on My Computer, select 

Properties, Hardware, and Device Manager. In Device Manager, select View and Show 

Hidden Devices.  

Depending on how XP was set up, you may find a number of networking devices--"Miniports"--

that the Networking applet didn't display. In my case, I found unnecessary PPOE, PPTP, L2TP, 

and Dial Out elements. I disabled all these unneeded elements, leaving only the IP miniport 

enabled, and thus restored some sense of control over my networking setup. Depending on how 

your system is set up, you may find other hidden devices, or no others. It varies hugely. But at 

least now you'll know if XP is hiding things from you.  

9) Take The Brakes Off Your Network Settings 
XP's default network settings for Maximum Transmission Unit, Receive Window, and such, may 

or may not be ideal for your circumstances. The only way to know is to take a close look: For 

example, DSL Reports and SpeedGuide have excellent free information, online tests, and even 
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one-click tweaks that can automatically optimize all or some of XP's internal plumbing for high-

speed connectivity. DSL Reports also offers a free, simple network tweaking tool called DrTCP 

that lets you instantly and easily adjust a variety of parameters; this tool makes iterative testing a 

snap, as you experiment to find the best settings for your particular setup.  

(Incidentally, when WinXP-specific solutions aren't offered, use those for Windows 2000; that's 

the closest match for XP.)  

10) Lock The Door 

XP has a built-in desktop firewall, but it's turned off by default. To turn it on: Right click on My 

Network Places, Properties, right click on your connection (e.g. Local Area Connection), 

select Properties again, then Advanced, and then click the box for Protect My Computer.  

But note that the built-in firewall is very basic, as the free LeakTest tool will demonstrate for 

you. A third-party firewall (such as ZoneAlarm will do a much better job than XP's built-in 

firewall.  

And whatever you use for desktop security, be sure to test your system using any of the safe, 

free, online security scans. Be sure to follow any suggestions the sites make to close security 

holes detected by the tests. For example, there are excellent tests available at:  

 Shields Up  

 DSL Reports Port Scan  

 DSL Reports Full Scan  

We've also discussed many other security services in earlier columns, such as this one. 

 

Revised 6/1/2009 JMM 

http://www.dslreports.com/front/drtcp.html
http://grc.com/lt/leaktest.htm
http://www.zonealarm.com/
https://grc.com/x/ne.dll?bh0bkyd2
http://www.dslreports.com/scan
http://www.dslreports.com/secureme
http://www.informationweek.com/841/langa.htm

